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Introduction 

The Component Data Collector (CODeC) is a data collection application.  It is intended to be used on the 

shop floor to record the required element data for Component Registration as required by the AAR’s 

Comprehensive Equipment Performance Monitoring (CEPM) program.  This program tracks the 

application of Wheelsets, Side Frames 1, Bolsters 1 , and Couplers 1 to the equipment.  For more 

information refer to the CEPM Program Overview at   

https://www.railinc.com/rportal/cepm-project-overview  

 

Once the data has been entered from CODeC it can be viewed, modified, and submitted to Railinc from 

Car Manager.  For more information about Car Manager refer to the Car Manager User Guide or contact 

us. 

 

  

                                                           
1
 Required in 2014 

https://www.railinc.com/rportal/cepm-project-overview
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System Requirements 

This application has minimum system requirements as described below. These requirements must be 

met in order for the application to operate as designed.  

This application supports the following Microsoft Windows operating systems. 

 Windows Vista SP2 (x86 and x64) 
 Windows 7 SP1 (x86 and x64) 
 Windows Server 2008 R2 SP1 (x64) 
 Windows Server 2008 SP2 (x86 and x64) 

The application requires the Microsoft .Net Framework 4.5 Full which can be obtained from Microsoft at 
http://www.microsoft.com/en-us/download/details.aspx?id=30653 

The application requires the following hardware at a minimum.  

 2.0 GHz Processor  
 1 GB installed RAM  
 100 MB available disk space  
 Ethernet Card  

   

http://www.microsoft.com/en-us/download/details.aspx?id=30653
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Getting Started 

Installing CODeC 

You will need Administrator rights to install CODeC. 

Make sure you have the latest version of our CODeC Setup program.  Contact our support team for 

assistance.  To install CODeC, run the setup program and follow the on screen prompts as described 

below: 

Click Next to continue. 
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Accept the license agreement and click Next. 

 

 

Select the location where you would like to install CODeC to and click Next. 
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Click Install to being the installation. 

 

 

When the installation has completed, click Finish to close the setup application. 
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Initial Setup 

Once you have installed CODeC you can double click the desktop shortcut to start the application. 

Database Connection Settings 

CODeCrequires access to an instance of the RIMS database which can be installed on the same 

computer or any computer with network access and the required permissions.  The first time you run 

CODeC you will be prompted to enter your database connection settings.  

Click OK to display the Connection Settings dialog. 

 

 

Click Configure. 
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Enter the connection settings for the server where the RIMS database is located.  If you are unsure 

contact your IT Department or our support team. 

Click Test Connection to verify your settings. 

Click OK when you are finished. 
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Click the Shop Name drop down to select the location for which you want to configure this installation.  

RIMS can support multiple locations or ‘shops’ hosted in one database.  In order to isolate the data and 

settings to your location you must provide this information. 

After you have selected the Shop Name click on Machine Name and select the machine you are 

installing on.  Some settings are stored per machine so this setting will be used to differentiate each 

installation.  

 

Click Save to save your changes.  

Once you have entered your database settings you will be prompted to log on.  You must have an 

existing user name and password in the RIMS system.  If you do not have this information, contact your 

manager or a system administrator.  See the following section regarding Log on for more information. 
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Log on / Log off 

Each user is given a unique user name and password for the RIMS system for authentication and 

accountability.  You must provide your user name and password each time CODeC starts before you can 

begin.  Your log on also determines what functions you have permissions to perform.  Users and Groups 

are managed from Car Manager.  For more information about permissions and users refer to the Car 

Manager User Guide. 

 

To log off the current user select Log off from the File menu.   



Revised 2013-09-30 

©2013 Arkansas Industrial Computing 10 
 

Options 

As with most applications there are system settings and user preferences that can be configured to 

customize the application to each shops preference.  Most of these can be configured from the Options 

dialog which can be found under the Tools menu. 

Scanner Setup 
In addition to collecting data for each component, a Component ID barcode label must be applied to the 

component as defined by Addendum S-920 of the AAR MSRP manual.  The barcode label that is applied 

must also be recorded along with the component data.  Although this can be entered manually it is 

recommended that a barcode scanner be used to scan the unique number on the Component ID 

barcode label. 

Before you can use a barcode scanner with the CODeC system you must first configure it from the 

Scanner Setup tab of the Options dialog.  

 

The Scanners list box shows all of the currently configured scanners. 

Select a scanner from the list and click Delete to remove an existing scanner 

Click Add to configure a new scanner. This will open the Configure Scanner dialog. 
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Enter a name for the scanner.  This could be used to designate location like ‘Left Side’ or ‘North’ or it 

could be a model number or color. 

CODeC allows multiple barcode scanner interface types including USB HID, Serial (RS232), and Ethernet 

(TCP/IP).  Select the interface Type for your scanner.  USB HID is the most common. 

In most cases you can use the Auto Detect feature by clicking the Auto Detect button.  For RS232 

scanners all available COM ports will be tested to look for a recognized serial scanner.  For USB you must 

scan a barcode with the desired scanner during the Auto Detect time limit (10 seconds).  Follow the on 

screen prompts to auto detect your scanner. 

Click Save to complete the scanner setup. 
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Component Types 
 

CODeC allows users to specify which components can be modified at the specific machine.  The 

Component Types tab in the Options menu lists available component types; check/uncheck the 

appropriate component types to control which can be modified from the Component Data Entry screen. 

 

User Interface 
The User Interface menu tab allows you to enable/disable the on-screen keyboard. 
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Registration 
The Registration tab allows you to specify your connection information to the RIMS services. 

 

In the Host field, enter the network name or IP address of the computer running the RIMS service.  For 

more information, contact an administrator or our support team. 

Required Fields 
The Required Fields tab allows you to specify which fields are required for saving a component.  Simply 

check/uncheck the box next to the field to indicate its requirement status. 

 

Note:  This changes the requirements to save a component to the database.  RailInc maintains its own 

registration requirements. 
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Reports 
The Reports tab allows you to specify which reports are accessible from CODeC.  To select/deselect an 

entire group, use the check box next to the group name.  To use only certain reports from a group, use 

the check boxes by the individual reports. 

 

For more information about adding and removing reports, see the Car Manager User Guide.  
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Full Screen Mode 

Although CODeC is intended as a stand-alone client running on the shop floor, some shops might find it 

useful to run CODeC on an existing computer that must perform additional tasks.  For this reason we 

have included an option to run CODeC in a windowed state instead of the default full screen application.  

This will enable you to easily switch between applications without having to exit  CODeC.  You can toggle 

‘Full Screen Mode’ from the Window menu to select between running full screen and windowed. You 

must have the appropriate permissions to change this setting. 

Reports 
CODeC includes the option to generate and view reports.  To access reports, click the ‘Reports’ item in 

the menu bar.  Then, select the report you wish to generate. 

 

To manage which reports appear in this menu, use the Reports tab in the options menu.  New reports 

must be imported through Car Manager.  
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Component Data Entry 

Component Types 
CODeC allows you to record data for almost every type of component required by the AAR.  The RIMS 

system is designed to allow adding additional component types as they become required by the AAR’s 

CEPM project.  

To select a component type that is configured for data collection, click on the tab at the top of the 

screen. 

 

 

Component ID 
In addition to the Component Element data, each component must be labeled with a Component ID 

barcode label and the number of that label must be entered in addition to the element data.  This label 

is a combination of the company code (2-4 characters) as designated by the AAR and a unique 10 digit id 

number to identify each component for a total of 14 characters.  (If the company code is less than 4 

characters it is padded with spaces to total 4 characters).  

 

  

https://www.railinc.com/rportal/cepm-project-overview
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Component Elements 
Each component has a list of ‘elements’ or data fields that can be collected.  This list is different for each 

component type.  Each field can be set as required or optional.  Please keep in mind that requirements 

are set by the AAR as well as by the shop administrators.  

Below is an example of the elements available for a side frame component. 

 

Element data can be any of any of the following types: text, numbers, dates, or list selection (from drop 

down list).  The data is validated to make sure it meets the required format. 

Fields shown in red are required in order to register a component with RailInc.  If any required field is 

left blank the user will be allowed to save the incomplete record, but the component will not be able to 

be registered until the missing fields have been filled. 

Once you have entered all required component data and applied a Component ID label you can click 

Save to save your changes.   

Cancel will reset the screen without saving the data you entered/changed. 
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Default Field Values 

 

CODeC allows field values to be set to default values in the case that certain elements do not change; 

this can be useful if a station runs components where certain characteristics are always the same. 

Another option is for fields to be set to repeat the previously saved value; this allows for easy 

incrimination or makes it easier if a large batch of similar components is being processed. 

To set default values for component details, database changes must be made.  If you have any questions 

or doubts about completing this task, contact an administrator or our support staff, as incorrectly 

modifying the database can cause serious problems throughout all apps in your RIMS setup. 

To set default values, you must open your database in 

Microsoft SQL Server Management Studio.  Expand the ‘Tables’ 

folder and then right-click on the ‘dbo.ElementDefaults’ table.  

Select ‘Edit Top 200 Rows’ from the menu. 

 

- AARShopCode: The shop code for the current station. 

- MachineNo: The machine number for the current 

station.  This can be found in the ‘dbo.Machines’ table. 

- ElementID:  This is the RailInc specified element ID for 

the field to be defaulted.  It can be found in the 

‘dbo.ElementDescriptions’ table or by hovering over 

the field with your mouse in CODeC. 

- Value:  This is the default value to be applied to the field.  There are several special commands 

that can be used, including “=lastvalue” which defaults the field to the last saved value.  Other 

special commands include “=Now” to insert the current date and time, “=Today” for the current 

date, “=Today.Month” for the current month, and “=Today.Year” for the current year. 

Again, please exercise caution when modifying any table in your database.  If you have any questions, 

STOP and call us.  We’re here to help.  
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Component Search 

Search by Component 
You can modify the data for a component that you already entered by searching for the component.  

Click the Search button in the top right corner of the screen to open the search Dialog. 

 

If the Component ID label is available and you have configured a barcode scanner you can simply scan 

the barcode to automatically retrieve the component record and display the element data. 

You can also manually search for the component using part of all of the Component ID.  As you type the 

Component ID a list of matching components will be displayed (once the results have been narrowed 

down to a manageable view).  If you see a message indicating too many results to display you need to 

enter more of the Component ID to narrow down the results.  If you see a message indicating no results 

found then the Component ID you entered does not match any components in the database.  See 

Appendix A: Frequently Asked Questions for help on problems with searching. 
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Search by Serial Number/Cast Date 
CODeC also allows you to search for components by Serial Number and Cast Month and Year.  To search 

by Serial Number or Cast Date, select Serial Number from the dropdown menu in the upper left corner 

of the Search for Component screen. 

 

Entering data into any of the three fields will display matching records in the results box.  Once you are 

through entering the search data, click Search to display results. 

 

Once you have found the component you are searching for you can double-click it or select it and click 

‘Select’ to retrieve the component record and display the element data. 

You can then make any necessary changes and Save or click Cancel to discard any changes and enter a 

new component. 
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Advanced Search 

 

CODeC’s Advanced Search feature allows users to customize searches beyond the standard search 

criteria to create targeted searches.  To access the Advanced Search window, open the standard search 

window and click the ‘>’ button. 

 

To begin creating your advanced search, select a search field from the dropdown box and enter/select a 

value for the field; when appropriate, you may change the operator to return a range of results instead 

of only those that equal the criteria.  For example, the search below would return all components 

created AFTER the selected date; changing the operator to ‘<=’ would return components created 

BEFORE the selected date. 

 

Once your first condition is complete, click the green ‘+’ button on the left of the window if you want to 

add another condition to your search. 

CODeC’s Advanced Search only searches certain fields by default; in order to 

specify a field that is not shown by default, check the ‘Show All Fields’ box in the 

bottom left corner of the pane.  Editing the fields shown by default requires altering your database 

entries for the element descriptions; for more information about this, contact your administrator or our 

support staff. 
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In order to search based on criteria that is specific to one type of component, such as a coupler’s cavity 

number, you must first select ‘ComponentTypeName’ and specify the type of component to which the 

criteria applies.  Once a component type is selected, click the green ‘+’ button on the left of the window 

to add another condition to your search.  Now, the Fields dropdown will include characteristics specific 

to the type of component selected in the first row. 

 

When you have finished entering the desired search conditions, click Search.  Your results will display in 

the Components List just like a standard search. 
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Appendix A: Frequently Asked Questions (FAQ) 
 

Q.  When searching for a component I receive a message that says ‘No Results Found...’ but I know entered the 
component. Why is it unable to be found? 

A.  Verify you are typing the number correctly in the search text box. If possible try scanning the Component ID 
barcode. 

Try entering the numeric portion of the Component ID without the company code and leading zeros.  It is possible 
the Component ID was entered incorrectly when the component was saved.   

If you cannot find the component from the CODeC search dialog we recommend you use Car Manager to search 
for the component.  Car Manager allows you to perform a more advanced search by component entry date, 
component type, and more. 

 

Q.  When searching for a component I receive a message that says ‘Too Many Results...’.  What does this mean?  

A.  The search dialog will show a list of components that match the search text you entered, but only if the search 
matches ten or fewer components.  Continue entering the Component ID until your results are narrowed down to 
ten or fewer matching components. 

 

Q.  When searching for a component by cast date, the component I’m looking for isn’t displayed in the 

results box, but I know I’m entering the correct month and/or year.  Why won’t my component show 

up? 

A.  In order to search for a component using the Serial Number option from the dropdown menu, the 

component must have been saved with a serial number entered.  If no serial number was saved to the 

component, it will not appear in the results of a Search by Serial Number; you must search for the 

component by its Component ID in order to retrieve the record.  You can then add a serial number to 

the component and it will appear in future searches by serial number. 

 

**Component AARE0000000007 would not appear if you searched for components cast in February of 2003 because 

it does not have a serial number.  
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Appendix B: License 

RAILCAR INTEGRATED MAINTENCANCE SUITE END USER LICENCSE AGREEMENT 

 

IMPORTANT NOTICE:  Read Before Installing or Using Software 

 

The following software products offered to you directly by Arkansas Industrial Computing (“AIC”) of 6100 
Getty Drive, Suite N, North Little Rock,  AR 72117 (voice 501-834-9540) is offered only for use in 
accordance with the terms and conditions of the RMS End User License Agreement below. 
 
BY INSTALLING OR USING ANY LICENSED SOFTWARE YOU WILL INDICATE THAT YOU HAVE 
READ, UNDERSTOOD, AND ACCEPT THESE TERMS AND CONDITIONS AND BECOME A PARTY 
TO THIS AGREEMENT.  IF YOU ARE UNABLE OR UNWILLING TO ENTER AND COMPLY WITH THIS 
AGREEMENT, DO NOT ATTEMPT TO INSTALL OR USE ANY LICENSED SOFTWARE.  INSTEAD, 
PROMPTLY RETURN ANY MATERIALS THAT WERE PROVIDED TO YOU.  CONTACT AIC IF YOU 
WISH TO DISCUSS THE AGREEMENT BELOW, BEFORE YOU ATTEMPT TO INSTALL OR USE ANY 
PRODUCT. 
 
RMS END USER LICENSE AGREEMENT 
 
LICENSE:  Subject to the terms and conditions of this Agreement, AIC hereby grants to you a non-
exclusive, non-transferable license to use the Licensed Software on one computer.  This includes 
reproducing the Licensed Software, but only as reasonably required to ensure appropriate back-up 
practices are followed.  All copies must bear all copyright and other proprietary rights notices which 
appear on the Licensed Software as originally provided by AIC.  Subject to the license expressly granted 
above, you obtain no right, title, interest or other license in or to any Product, including but not limited to 
any copyright, patent, trade secret, trademark, or other proprietary rights therein.  All whole and partial 
copies of the Licensed Software remain the property of AIC and will be considered part of the Licensed 
Software for the purpose of this Agreement.   
 
Unless expressly permitted by this Agreement, or otherwise by applicable law or by AIC in writing, you 
shall not: (i) use, reproduce, modify, adapt, translate, update or transmit any Licensed Software, in whole 
or in part; (ii) rent, lease, license, transfer, or otherwise provide access to any Licensed Software; (iii) 
alter, remove, or cover trademarks or proprietary notices in or on any Licensed Software; (iv) export any 
Licensed Software from the country in which it was provided to you by AIC; (v) decompile, disassemble, 
decrypt, extract or otherwise attempt or assist others to reverse engineer any Licensed Software, except 
as necessary, when permitted by an applicable law, to correct defects or achieve interoperability with 
complimentary programs, for your purposes only, but only if AIC has refused to provide the necessary 
information or assistance.  Unless AIC has provided you with express written consent, the Licensed 
Software may not be used in any application in which the failure of the Licensed Software could lead 
directly to death, personal injury, or severe physical or property damage (collectively, “High-Risk 
Activities”).  AIC EXPRESSLY DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY OR CONDITION 
OF FITNESS FOR HIGH-RISK ACTIVITIES. 
 
WARRANTY:  AIC cannot warrant that any Licensed Software will function in accordance with related 
documentation in every combination of hardware platform, software environment, and Licensed Software 
configuration.   
 
LIMITATIONS:  EXCEPT AS EXPRESSLY WARRANTED ABOVE, THE LICENSED SOFTWARE AND 
ANY ASSOCIATED AIC MEDIA ARE PROVIDED “AS IS” WITHOUT OTHER WARRANTIES OR 
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CONDITIONS OF ANY KIND, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES AND 
CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. YOU ASSUME THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF 
THE LICENSED SOFTWARE.  NOTHING STATED IN THIS AGREEMENT WILL IMPLY THAT THE 
OPERATION OF ANY LICENSED SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE OR 
THAT ERRORS WILL BE CORRECTED.  OTHER WRITTEN OR ORAL STATEMENTS BY AIC, ITS 
REPRESENTATIVES OR OTHERS DO NOT CONSTITUTE WARRANTIES OF AIC. 
 
IN NO EVENT WILL AIC (OR IT’S OFFICERS, EMPLOYEES, AGENTS, SUPPLIERS, DISTRIBUTORS, 
OR LICENSORS – COLLECTIVELY “ITS REPRESENTATIVES”) BE LIABLE TO YOU FOR ANY 
INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING 
BUT NOT LIMITED TO LOST REVENUE, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR 
ECONOMIC LOSS, ARISING OUT OF OR RELATING TO ANY BREACH OF THIS AGREEMENT, ANY 
USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY CLAIM MADE BY A THIRD 
PARTY, EVEN IF AIC OR IT’S REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGE OR CLAIM. 
 
IN NO EVENT WILL THE AGGREGATE LIABILITY OF AIC AND IT’S REPRESENTATIVES FOR ANY 
DAMAGES OR CLAIMS ARISING OUT OF OR RELATING TO THIS AGREEMENT OR ANY LICENSED 
SOFTWARE, WHETHER IN CONTRACT, TORT, OR OTHERWISE, EXCEED THE LICENSE FEES 
YOU PAID FOR THE USE OF THE LICENSED SOFTWARE UNDER THIS AGREEMENT.  AIC’S AND 
IT’S REPRESENTATIVE’S LIMITATION OF LIABILITY IS CUMULATIVE WITH ALL OF AIC’S AND IT’S 
REPRESENTATIVE’S PAYMENTS IN SATISFACTION OF THEIR LIABILITIES BEING AGGREGATED 
TO DETERMINE SATISFACTION OF THE LIMIT. 
 
These limitations shall apply whether or not the alleged breach is a fundamental breach of contract.  
Some jurisdictions curtail limitations of liability for incidental or consequential damages, and/or limitations 
of implied warranties.  Therefore, to the extent prohibited by applicable law, the above limitations may not 
apply to you. 
 
TERM:  This Agreement commences upon your acceptance (as described above) and will end when 
terminated.  You may terminate this Agreement at any time.  It will be deemed to terminate immediately if 
you fail to comply with any material term herein.  Upon termination, your license rights end and you shall 
immediately destroy all whole or partial copies of all Licensed Software in your possession or control. 
 
GENERAL:  This Agreement is governed by and will be construed in accordance with the laws in force in 
the State of Arkansas, United States of America without regard to the conflict of laws provisions therein.  
The parties expressly disclaim the provisions of the United Nations Convention on Contracts for the 
International Sale of Goods.  This Agreement constitutes the entire agreement between you and AIC 
pertaining to the Licensed Software and any associated AIC media, and supersedes all prior or 
contemporaneous agreements, understandings, negotiations, and discussions, whether oral or written.  
No amendment or waiver of any term of this Agreement will be binding unless executed in writing by the 
parties.  Subject to the export restrictions provided above, you are entitled to assign this Agreement to a 
third party who has provided AIC with prior written acknowledgement of their acceptance of the terms and 
conditions herein.  In such a case you will transfer all copies of the Licensed Software and any associated 
media to the assignee.  The provisions of this Agreement will ensure to the benefit of and will be binding 
upon the parties and their respective successors and permitted assigns.  If any provision of this 
Agreement is held by a court of competent jurisdiction to be illegal, invalid, or unenforceable, the 
remaining provisions shall remain in full force and effect.  
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Appendix C: Contact Information 
 

AIC Rail 
6100 Getty Drive  
Suite N 
Sherwood, AR 72117 
 

Online Support 
Visit our website at www.aicrail.com for 24/7 technical information and available downloads 
Email us at support@wheelshopautomation.com 
 
Phone Support (Existing support contract or credit card required) 
Call 1-501-834-9540 or 1-877-834-9540 (toll free) 

http://www.aicrail.com/

